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What	is	JNI	and	why	do	you	need	it	?

JNI	is	the	Java	Native	Interface.	It	is	needed	to	do	calls	to/from	Java	world	from/to	native	(C/C++)
world.

It	is	impossible	for	Qt	to	implement	all	Android	features,	so	to	use	them	you'll	need	JNI	to	access
them.

JNI	Crash	Course
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Missing	Qt	APIs

listening	for	Android	O.S.	notifications:

sd	card	notifications:	bad	removal,	eject,	mounted,	unmounted,	etc.

network	notifications:	network	up/down.

battery	level	and	charging	state.

etc.

accessing	Android	O.S.	features:

telephony	(Initiate	calls,	MMS,	SMS,	etc.)

contacts

speech	(TTS	and	Speech	Recognizer)

system	accounts

system	preferences

NFC

USB

printing	(WARNING:	needs	API-19+)

create	own	Android	Activities	and	Services

JNI	Crash	Course
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Use	case	1:	call	a	Java	function
from	C/C++

Use	case	1:	call	a	Java	function	from	C/C++
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Create	the	Java	function

1 //	java	file	android/src/com/kdab/training/MyJavaClass.java
2 package	com.kdab.training;
3
4 public	class	MyJavaClass
5 {
6     //	this	method	will	be	called	from	C/C++
7     public	static	int	fibonacci(int	n)
8     {
9         if	(n	<	2)
10             return	n;
11         return	fibonacci(n-1)	+	fibonacci(n-2);
12     }
13 }

Demo	android/JNIIntro

Use	case	1:	call	a	Java	function	from	C/C++
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Call	a	Java	method	from	C/C++,	the	Qt	way

Let's	see	what	fibonacci	function	call	looks	like	using	the	Qt	androidextras	module.

1 #	Changes	to	your	.pro	file
2 #	....
3 QT	+=	androidextras
4 #	....

1 //	C++	code
2 #include	<QAndroidJniObject>
3 int	fibonacci(int	n)
4 {
5     return	QAndroidJniObject::callStaticMethod<jint>
6                         ("com/kdab/training/MyJavaClass"	//	java	class	name
7                         ,	"fibonacci"	//	method	name
8                         ,	"(I)I"	//	signature
9                         ,	n);
10 }

Yes,	that's	all	folks	!

Use	case	1:	call	a	Java	function	from	C/C++



p.9

JNI	Crash	Course

Use	case	2:	callback	a	C/C++
function	from	Java

Use	case	2:	callback	a	C/C++	function	from	Java
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Your	job

declare	a	native	method	in	Java	using	native	keyword	(see	slide	11)

register	native	method	in	C/C++	(see	slide	12,	slide	15	)

do	the	actual	call	(see	slide	11)

Use	case	2:	callback	a	C/C++	function	from	Java

gotoPage://11
gotoPage://12
gotoPage://15
gotoPage://11
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Declare	and	invoke	the	Java	native	methods

1 //	java	file	android/src/com/kdab/training/MyJavaClass.java
2 package	com.kdab.training;
3
4 class	MyJavaNatives
5 {
6     //	declare	the	native	method
7     public	static	native	void	sendFibonaciResult(int	n);
8 }
9
10 public	class	MyJavaClass
11 {
12     //	this	method	will	be	called	from	C/C++
13     public	static	int	fibonacci(int	n)
14     {
15         if	(n	<	2)
16             return	n;
17         return	fibonacci(n-1)	+	fibonacci(n-2);
18     }
19
20     public	static	void	compute_fibonacci(int	n)
21     {
22         //	callback	the	native	method	with	the	computed	result.
23         MyJavaNatives.sendFibonaciResult(fibonacci(n));
24     }
25 }

Use	case	2:	callback	a	C/C++	function	from	Java
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C/C++	register	native	methods

Registering	functions	using	Java_Fully_Qualified_Class_Name_MethodName	template.

1 //	C++	code
2 #include	<jni.h>
3
4 #ifdef	__cplusplus
5 extern	"C"	{
6 #endif
7
8 JNIEXPORT	void	JNICALL
9     Java_com_kdab_training_MyJavaNatives_sendFibonaciResult(JNIEnv	*/*env*/,
10                                                     jobject	/*obj*/,
11                                                     jint	n)
12 {
13     qDebug()	<<	"Computed	fibonacci	is:"	<<	n;
14 }
15
16 #ifdef	__cplusplus
17 }
18 #endif

Use	case	2:	callback	a	C/C++	function	from	Java
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Using	Java_Fully_Qualified_Class_Name_MethodName.

Pro:

easier	to	declare,	you	don't	need	to	specify	the	function	signature

easier	to	register,	you	don't	need	to	explicitly	register	it

Con:

the	function	names	are	huge:
Java_com_kdab_training_MyJavaNatives_sendFibonaciResult

the	library	will	export	lots	of	functions

unsafer,	there	is	no	way	for	the	VM	to	check	the	function	signature

Use	case	2:	callback	a	C/C++	function	from	Java
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Use	JNIEnv::RegisterNatives	to	register	native	functions.

Step	4	call	JNIEnv::RegisterNatives(java_class_ID,	methods_vector,	n_methods)

Step	3	find	the	ID	of	java	class	that	declares	these	methods	using	JniEnv::FindClass

Step	2	create	a	vector	with	all	C/C++	methods	that	you	want	to	register

Step	1	get	JNIEnv	pointer	by	defining	
JNIEXPORT	jint	JNI_OnLoad(JavaVM*	vm,	void*	/*reserved*/).
You	can	define	it	(once	per	.so	file)	in	any	.cpp	file	you	like

Use	case	2:	callback	a	C/C++	function	from	Java
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Use	JNIEnv::RegisterNatives

1 //	C++	code
2 #include	<jni.h>
3
4 //	define	our	native	method
5 static	void	sendFibonaciResult(JNIEnv	*/*env*/,	jobject	/*obj*/,	jint	n)
6 {
7     qDebug()	<<	"Computed	fibonacci	is:"	<<	n;
8 }
9
10 //	step	2
11 //	create	a	vector	with	all	our	JNINativeMethod(s)
12 static	JNINativeMethod	methods[]	=	{
13      {	"sendFibonaciResult",	//	const	char*	function	name;
14        "(I)V",	//	const	char*	function	signature
15        (void	*)sendFibonaciResult	//	function	pointer	}
16 };	

Use	case	2:	callback	a	C/C++	function	from	Java
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Use	JNIEnv::RegisterNatives

1 //	step	1
2 //	this	method	is	called	automatically	by	Java	after	the	.so	file	is	loaded
3 JNIEXPORT	jint	JNI_OnLoad(JavaVM*	vm,	void*	/*reserved*/)
4 {
5     JNIEnv*	env;
6     //	get	the	JNIEnv	pointer.
7     if	(vm->GetEnv(reinterpret_cast<void**>(&env),	JNI_VERSION_1_6)	!=	JNI_OK)
8         return	JNI_ERR;
9
10     //	step	3
11     //	search	for	Java	class	which	declares	the	native	methods
12     jclass	javaClass	=	env->FindClass("com/kdab/training/MyJavaNatives");
13     if	(!javaClass)
14         return	JNI_ERR;
15
16     //	step	4
17     //	register	our	native	methods
18     if	(env->RegisterNatives(javaClass,	methods,
19                             sizeof(methods)	/	sizeof(methods[0]))	<	0)	{
20         return	JNI_ERR;
21     }
22     return	JNI_VERSION_1_6;
23 }

Use	case	2:	callback	a	C/C++	function	from	Java
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Use	JNIEnv::RegisterNatives

Pro:

the	native	function	can	have	any	name	you	want

the	library	needs	to	export	only	one	function	(JNI_OnLoad).

safer,	because	the	VM	checks	the	declared	signature

Con:

is	slightly	harder	to	use

Use	case	2:	callback	a	C/C++	function	from	Java



p.18

Extending	your	application	using	JNI

SD	Card	Notifications	Example

SD	Card	Notifications	Example
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Game	plan

Plumbing

understanding	Android	files

how	to	use	an	external	IDE	to	manage	the	Java	part

import	existing	Android	files

debug	Java

Architecture

how	to	extend	the	Java	part	of	your	Qt	Application

how	to	do	safe	calls	from	Qt	thread	to	Android	UI	thread

how	to	do	safe	calls	from	Android	UI	thread	to	Qt	thread

SD	Card	Notifications	Example
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SD	Card	Notifications	Example

Understanding	Android	files

Understanding	Android	files
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Copy	missing	Android	files

copy	all	files	from	<qt_install_path>/src/android/java/	to	<your_src>/android/	folder

make	sure	your	.pro	file	has	ANDROID_PACKAGE_SOURCE_DIR	property	set

ANDROID_PACKAGE_SOURCE_DIR	=	$$PWD/android

Understanding	Android	files
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Meaning	of	the	Android	files

AndroidManifest.xml	-	is	the	same	file	copied	by	Qt	Creator	when	you	click	on	Create
AndroidManifest.xml	button.

version.xml	-	is	used	by	Qt	Creator	to	update	your	existing	Android	files

res/values/libs.xml	-	this	file	contains	the	information	about	the	needed	libs

res/values(-*)/strings.xml	-	these	files	contain	the	(translated)	strings	needed	by	Java	part

src/org/kde/necessitas/ministro/	*.aidl	-	these	files	are	used	to	connect	to	Ministro	service

src/org/qtproject/qt5/android/bindings/QtApplication.java	-	this	class	contains	all	the	logic	needed	to
forward	all	the	activity	calls	to	the	activity	delegate

src/org/qtproject/qt5/android/bindings/QtActivity.java	-	this	is	the	application	activity	class,	it
contains	the	logic	to	connect	to	Ministro	or	to	unpack	the	bundled	Qt	libs.	It	also	forwards	all	calls	to
the	activity	delegate.

Understanding	Android	files
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SD	Card	Notifications	Example

Using	an	external	IDE	for	Java
part

Using	an	external	IDE	for	Java	part
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Using	an	external	IDE	to	extend	the	Java	part

Sadly,	the	Java	support	in	Qt	Creator	is	close	to	zero,	so	we	need	to	use	an	external	IDE	to	easily	extend
the	Java	part.	Android	provides	two	powerful	IDEs:

Eclipse

Android	Studio	(this	is	very	good	and	stable	even	though	it	is	labeled	as	beta).

Using	an	external	IDE	for	Java	part
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Eclipse	users

If	you	are	not	using	ADT	bundle,	then	make	sure	you	have	all	ADT	plugins	installed	in	Eclipse.

Using	an	external	IDE	for	Java	part
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Using	an	external	IDE

The	external	IDE	will	be	used	to:

import	existing	Android	files

create	and	edit	Java	files

debug	Java	part

The	external	IDE	will	NOT	be	used	to	run	the	application,	we	still	need	QtCreator	for	that	job!

Using	an	external	IDE	for	Java	part



p.27

This	presentation	will	teach	you	only	the	very	basic	usage	of	both	of	them.	If	you	want	to	learn	more
please	check	their	own	documentation.	
Also	it's	up	to	you	which	one	you	choose	to	use.

Using	an	external	IDE	for	Java	part
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Using	an	external	IDE	for	Java	part

Import	existing	Android	files	in
Eclipse

Import	existing	Android	files	in	Eclipse
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WARNING

Before	you	start	to	import	the	project	make	sure	the	Build	Automatically	feature	is	turned	OFF!
Otherwise	when	you	start	to	build	your	project	you'll	get	lots	of	mysterious	build	problems.
Uncheck	Project->Build	Automatically

Import	existing	Android	files	in	Eclipse
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Importing	in	Eclipse

File->New->Project	...

Import	existing	Android	files	in	Eclipse
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Importing	in	Eclipse

Choose	Android	Project	from	Existing	Code	wizard

Import	existing	Android	files	in	Eclipse
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Importing	in	Eclipse

Select	the	root	folder	of	your	Android	files	(it	should	be	your_qt_src/android)	and	press	Finish	button.

Import	existing	Android	files	in	Eclipse
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Using	an	external	IDE	for	Java	part

Import	existing	Android	files	in
Android	Studio

Import	existing	Android	files	in	Android	Studio
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Importing	in	Android	Studio

File->Import	project	... 	does	all	the	magic,	you	just	need	to	select	the	root	folder	of	your	Android	files
(it	should	be	your_qt_src/android)	and	continue	the	wizard	until	it	is	finished.

Import	existing	Android	files	in	Android	Studio
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Using	an	external	IDE	for	Java	part

Debugging	Java	part

Debugging	Java	part



p.36

Debug	with	Eclipse

set	the	break	points

switch	to	DDMS	perspective	(Window->Open	perspective->DDMS)

start	the	application	(using	QtCreator)

wait	for	application	to	start

select	the	application

click	the	debug	icon

Debugging	Java	part
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Debug	with	Android	Studio

set	the	break	points

attach	debugger	(Run->Attach	debugger	to	Android	process)

start	the	application	(using	QtCreator)

wait	for	application	to	start

select	the	application

click	the	OK	button

Debugging	Java	part
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Debugging	tips	and	tricks

The	problem	comes	when	we	need	to	start	the	debugging	very	early.	To	do	that	we	are	going	to	use	the
old	fashioned	sleep	trick.	This	is	how	our	custom	onCreate	function	looks:

1 @Override
2 public	void	onCreate(Bundle	savedInstanceState)
3 {
4     try	{
5         Thread.sleep(10000);
6     }	catch	(InterruptedException	e)	{
7         e.printStackTrace();
8     }
9     ....
10 }

Debugging	Java	part
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Architecture	diagram

SD	Card	Notifications	Example
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SD	Card	Notifications	Example

Extending	Java	part

Extending	Java	part
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Extending,	not	changing

You	should	not	change	any	of	the	existing	.java	files,	instead	you	should	extend	them

There	is	no	need	to	extend	the	QtApplication	application	class

You	should	extend	only	the	QtActivity	class.	The	Activity	object	is	very	important,	you'll	need	it	to
instantiate	most	of	the	Android	classes

Demo	android/SD_Card_Notifications

Extending	Java	part
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Extending	QtActivity

1 //	src/com/kdab/training/MyActivity.java
2 package	com.kdab.training;
3
4 import	android.os.Bundle;
5 import	org.qtproject.qt5.android.bindings.QtActivity;
6
7 public	class	MyActivity	extends	QtActivity
8 {
9     //	we'll	need	it	in	BroadcastReceiver
10     public	static	MyActivity	s_activity	=	null;
11
12     //	every	time	you	override	a	method,	always	make	sure	you
13     //	then	call	super	method	as	well
14     @Override
15     public	void	onCreate(Bundle	savedInstanceState)
16     {
17         s_activity	=	this;
18         super.onCreate(savedInstanceState);
19     }
20
21     @Override
22     protected	void	onDestroy()
23     {
24         super.onDestroy();
25         s_activity	=	null;
26     }
27 }

Extending	Java	part
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Extending	Java	part

Change	default	activity	to	AndroidManifest.xml,	from:

1 <activity	...
2         android:name="org.qtproject.qt5.android.bindings.QtActivity"
3         ...	>;

 To:

1 <activity	...
2         android:name="com.kdab.training.MyActivity"
3         ...	>;

Extending	Java	part



p.44

NativeFunctions.java	part	1

1 public	class	NativeFunctions	{
2     //	declare	the	native	functions
3     //	these	functions	will	be	called	by	the	BroadcastReceiver	object
4     //	when	it	receives	a	new	notification
5     public	static	native	void	onReceiveNativeMounted();
6     public	static	native	void	onReceiveNativeUnmounted();
7
8     //	this	static	method	is	called	by	C/C++	to	register	the	BroadcastReceiver.	(step	1)
9     public	static	void	registerBroadcastReceiver()	{
10         if	(MyActivity.s_activity	!=	null)	{
11             //	Qt	is	running	on	a	different	thread	than	Android.	(step	2)
12             //	In	order	to	register	the	receiver	we	need	to	execute	it	in	the	UI	thread
13             MyActivity.s_activity.runOnUiThread(	new	RegisterReceiverRunnable());
14         }
15     }
16 }

Extending	Java	part
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NativeFunctions.java	part	2

1 class	RegisterReceiverRunnable	implements	Runnable
2 {
3     //	Step	3
4     //	this	method	is	called	on	Android	Ui	Thread
5     @Override
6     public	void	run()	{
7         IntentFilter	filter	=	new	IntentFilter();
8         filter.addAction(Intent.ACTION_MEDIA_MOUNTED);
9         filter.addAction(Intent.ACTION_MEDIA_UNMOUNTED);
10         filter.addDataScheme("file");
11         //	this	method	must	be	called	on	Android	Ui	Thread
12         MyActivity.s_activity.registerReceiver(new	SDCardReceiver(),	filter);
13     }
14 }

Extending	Java	part
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NativeFunctions.java	part	3

1 class	SDCardReceiver	extends	BroadcastReceiver	{
2     @Override
3     public	void	onReceive(Context	context,	Intent	intent)	{
4         //	Step	4
5         //	call	the	native	method	when	it	receives	a	new	notification
6         if	(intent.getAction().equals(Intent.ACTION_MEDIA_MOUNTED))
7             NativeFunctions.onReceiveNativeMounted();
8         else	if	(intent.getAction().equals(Intent.ACTION_MEDIA_UNMOUNTED))
9             NativeFunctions.onReceiveNativeUnmounted();
10     }
11 }

Extending	Java	part
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Architecture	diagram,	Java	part

Extending	Java	part



p.48

SD	Card	Notifications	Example

Extending	C/C++	part

Extending	C/C++	part
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main.cpp

1 #include	"mainwindow.h"
2 #include	<QApplication>
3 #include	<QAndroidJniObject>
4
5 int	main(int	argc,	char	*argv[])
6 {
7     QApplication	a(argc,	argv);
8
9     //	Step	1.
10     //	call	registerBroadcastReceiver	to	register	the	broadcast	receiver
11     QAndroidJniObject::callStaticMethod<void>("com/kdab/training/NativeFunctions"
12                                      ,	"registerBroadcastReceiver"
13                                      ,	"()V");
14
15     MainWindow::instance().show();
16     return	a.exec();
17 }

Extending	C/C++	part
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mainwindow.h

1 class	MainWindow	:	public	QMainWindow
2 {
3     Q_OBJECT
4
5 public:
6     static	MainWindow	&instance(QWidget	*parent	=	0);
7
8 public	slots:
9     void	onReceiveMounted();
10     void	onReceiveUnmounted();
11
12 private:
13     explicit	MainWindow(QWidget	*parent	=	0);
14     ~MainWindow();
15
16 private:
17     Ui::MainWindow	*ui;
18 };

Extending	C/C++	part
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mainwindow.cpp

1 MainWindow	&MainWindow::instance(QWidget	*parent)
2 {
3     static	MainWindow	mainWindow(parent);
4     return	mainWindow;
5 }
6
7 //	Step	6
8 //	Callback	in	Qt	thread
9 void	MainWindow::onReceiveMounted()
10 {
11     ui->plainTextEdit->appendPlainText(QLatin1String("MEDIA_MOUNTED"));
12 }
13
14 void	MainWindow::onReceiveUnmounted()
15 {
16     ui->plainTextEdit->appendPlainText(QLatin1String("MEDIA_UNMOUNTED"));
17 }

Extending	C/C++	part
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native.cpp	part	1

1 //	Step	4.	callback	from	java	in	Android	thread
2 //	define	our	native	methods
3 static	void	onReceiveNativeMounted(JNIEnv	*/*env*/,	jobject	/*obj*/)
4 {
5     //	Step	5.	Delegate	the	call	to	Qt	thread.
6     QMetaObject::invokeMethod(&MainWindow::instance(),	"onReceiveMounted"
7                             ,	Qt::BlockingQueuedConnection);
8 }
9
10 static	void	onReceiveNativeUnmounted(JNIEnv	*/*env*/,	jobject	/*obj*/)
11 {
12     //	Step	5.	Delegate	the	call	to	Qt	thread.
13     QMetaObject::invokeMethod(&MainWindow::instance(),	"onReceiveUnmounted"
14                             ,	Qt::BlockingQueuedConnection);
15 }

Extending	C/C++	part
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native.cpp	part	2

1 //create	a	vector	with	all	our	JNINativeMethod(s)
2 static	JNINativeMethod	methods[]	=	{
3     {"onReceiveNativeMounted",	"()V",	(void	*)onReceiveNativeMounted},
4     {"onReceiveNativeUnmounted",	"()V",	(void	*)onReceiveNativeUnmounted},
5 };
6
7 //	this	method	is	called	automatically	by	Java	after	the	.so	file	is	loaded
8 JNIEXPORT	jint	JNI_OnLoad(JavaVM*	vm,	void*	/*reserved*/)
9 {
10     JNIEnv*	env;	//	get	the	JNIEnv	pointer.
11     if	(vm->GetEnv(reinterpret_cast<void**>(&env),	JNI_VERSION_1_6)	!=	JNI_OK)
12         return	JNI_ERR;
13
14     //	search	for	Java	class	which	declares	the	native	methods
15     jclass	javaClass	=	env->FindClass("com/kdab/training/NativeFunctions");
16     if	(!javaClass)
17         return	JNI_ERR;
18
19     //	register	our	native	methods
20     if	(env->RegisterNatives(javaClass,	methods,
21                         sizeof(methods)	/	sizeof(methods[0]))	<	0)	{
22         return	JNI_ERR;
23     }
24     return	JNI_VERSION_1_6;
25 }

Extending	C/C++	part
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Architecture	diagram,	Qt	JNI	part

Extending	C/C++	part
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Architecture	diagram,	summary

Extending	C/C++	part
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Questions	?

Thank	you	for	your	time!

Contact	us:

http://www.kdab.com

qtonandroid@kdab.com

info@kdab.com

training@kdab.com

bogdan@kdab.com

http://www.kdab.com

